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Quick Start to Autodesk
3ds Max 2008 Installation

This section provides quick start instructions on how to install Autodesk 3ds Max 2008 on
your system. You should read the entire Autodesk 3ds Max 2008 Installation Guide if you have
any questions that are not addressed in this Quick Start section.

For network installs, you can also install Autodesk 3ds Max by deploying the program. This
can be especially useful when you want to install Autodesk 3ds Max on many machines on
a network. To deploy Autodesk 3ds Max, see the Autodesk 3ds Max 2008 Network Administrator’s
Guide, which you can access from the Documentation link in the Autodesk 3ds Max 2008
Installation Wizard.

How to Use this Document

This document is divided into four chapters. Read the chapter descriptions to
see which ones contain information that pertains to your situation.

B See the Quick Start to Autodesk 3ds Max 2008 Installation on page 1 for
a quick overview of the install process. If your install is straightforward, this
may be sufficient information.

B See the Installing Autodesk 3ds Max on page 5 for a detailed explanation
of how to install, start, and license Autodesk 3ds Max 2008. Also find out
about customizing your installation.

B See the Supplemental Tools and Utilities on page 43 for an explanation of
the various supplementary tools that you may wish to install.

B Sece the Installation Troubleshooting on page 61 if you have any problems
or questions during your installation.



Preparing for Installation

Before you install Autodesk 3ds Max®, you need to perform a few tasks. These
steps are briefly outlined in this chapter or described in more detail in
Installing Autodesk 3ds Max on page S .

Verifying System Requirements

Make sure that the computer on which you install Autodesk 3ds Max meets
the system requirements. If your system does not meet the system
requirements, many problems can occur, both within Autodesk 3ds Max and
at the operating system level.

To review the system requirements, see System Requirements on page S .

Obtaining Administrative Permissions

To install Autodesk 3ds Max, you must have administrator permissions. See
Administrative Permission Requirements on page 12 for complete details.

Other Programs Overview

Certain other programs may cause problems during the Autodesk 3ds Max
installation. See Closing Other Programs During Installation on page 2 for
a complete list of these programs.

Installing and Running Autodesk 3ds Max

To use the product, you must install the product, launch it, and then register
and activate it.

Installing Autodesk 3ds Max

1 Insert DVD 1 into your computer's drive.

2 In the Autodesk 3ds Max Installation Wizard, click Install Products.

2 | Chapter | Quick Start to Autodesk 3ds Max 2008 Installation



3 Follow the directions on each installation page.

For detailed instructions on installing Autodesk 3ds Max, see Installing
Autodesk 3ds Max on page 5 .

Autodesk 3ds Max Serial Number Overview

You will need the Autodesk 3ds Max serial number found on the outside of
the Autodesk 3ds Max 2008 DVD case to activate Autodesk 3ds Max 2008. See
Locating Your Autodesk 3ds Max Serial Number on page 3 for more
information, including for Autodesk store (online store) downloads.

Registering and Activating Autodesk 3ds Max

After Autodesk 3ds Max is installed, you can initiate the registration process
by launching the product. When you launch Autodesk 3ds Max, the Product
Activation wizard is displayed. Follow the directions in the Product Activation
wizard to register the product.

NOTE If you are upgrading from an earlier release of Autodesk 3ds Max, use your
new serial number when you register and activate the new release.

For detailed instructions on registering Autodesk 3ds Max, see Registering
and Activating Autodesk 3ds Max on page 26 .

Starting Autodesk 3ds Max

You can start Autodesk 3ds Max from a desktop shortcut, the Start menu, or
from the location where you installed Autodesk 3ds Max (with administrator
permissions). See Starting Autodesk 3ds Max on page 25 for further details.

Learning About New Features

For more information about the new features, see the “What’s New” section
in the Autodesk 3ds Max Help (accessible from the Help menu in Autodesk 3ds
Max 2008).

Autodesk 3ds Max Serial Number Overview | 3



Autodesk 3ds Max on the Web

Check out the following web sites for additional Autodesk 3ds Max 2008
information.

4 | Chapter |

http://www.autodesk.com/3dsmax for product information and related links.

http://www.autodesk.com/3dsmax-learningpath for a map to online learning
resources such as tutorials, videos, and help.

http://www.autodesk.com/3dsmax-support for Autodesk 3ds Max support.

Quick Start to Autodesk 3ds Max 2008 Installation
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Installing Autodesk 3ds
Max

This section provides detailed instructions for installing and activating Autodesk 3ds Max for
an individual user. For information about installing network-licensed or multi-seat
standalone-licensed versions of the program, see the Autodesk 3ds Max 2008 Network
Administrator's Guide, located on the Documentation tab of the Installation Wizard.

System Requirements

Before you begin the install process, make sure your system meets the minimum
software and hardware operating requirements for Autodesk 3ds Max 2008.

Operating Systems

The supported operating systems depend on whether you are running Autodesk
3ds Max 2008 32-bit or 64-bit.

32-Bit Version of Autodesk 3ds Max 2008

The following are the supported operating systems for the 32-bit version of
Autodesk 3ds Max 2008.

B Microsoft® Windows® Vista™

B Microsoft® Windows® XP Professional (Service Pack 2 or higher)



m NOTE Windows® XP Home Edition, Windows® 2000, Windows 98 and
Windows ME, Windows NT, and Windows 2003 (Server) are not supported
operating systems.

64-Bit Version of Autodesk 3ds Max 2008

The following are the supported operating systems for the 64-bit version of
Autodesk 3ds Max 2008.

B Microsoft® Windows® Vista™

B Microsoft® Windows® XP Professional x64, which is the recommended 64-bit
operating system.

Hardware Requirements

Certain hardware requirements apply to both the 32- and 64-bit versions of
Autodesk 3ds Max 2008, while others apply to only one or the other.

32-Bit Version of Autodesk 3ds Max 2008

The 32-bit version of Autodesk 3ds Max 2008 requires the following hardware:

Hardware Item: Minimum Requirements:

Processor B Intel® Pentium® IV or AMD® Athlon® XP processor or
higher (dual processor machine recommended)

Hard Disk B 500 MB of swap space but 2 GB is recommended.

RAM B 512 MB RAM but 1 GB is recommended

6 | Chapter 2 Installing Autodesk 3ds Max



Hardware Item: Minimum Requirements:

NOTE The complexity of your scene impacts the amount of
RAM you need to maintain performance.

64-Bit Version of Autodesk 3ds Max 2008

The 64-bit version of Autodesk 3ds Max 2008 requires the following hardware:

Hardware Item: Minimum Requirements:

Processor B Intel® EM64T, AMD® Athlon® 64 or higher, or AMD
Opteron processor

Hard Disk B 500 MB of swap space but 2 GB is recommended.

RAM H 1 GB RAM but 4 GB is recommended

NOTE The complexity of your scene impacts the amount of
RAM you need to maintain performance.

Shared Hardware Requirements (32- and 64-Bit)

Both 32- and 64-bit machines require the following hardware.

Hardware Item: Minimum Requirements:

Display Minimum B Graphics cards that support a minimum resolution of 1024
X 768 x 16-bit color.

Hardware Accelera- W Hardware-accelerated OpenGL® and Direct3D with a reso-
tion lution set to 1280 x 1024 x 32-bit color (or higher) is both
supported and recommended. OpenGL and Direct3D®

Hardware Requirements | 7



Hardware Item: Minimum Requirements:

hardware acceleration is supported with graphics cards
having a minimum of 32 MB of memory.

B Some features of Autodesk 3ds Max 2008 are only enabled
when used with graphics hardware that supports Shader
Model 3.0 (Pixel Shader and Vertex Shader 3.0). Check
with your manufacturer to determine whether your hard-
ware supports this.

NOTE 256-color mode is not supported.

Mouse/Tablet with B Microsoft® Windows®-compliant pointing device (optimized
Pen for Microsoft® IntelliMouse®)
DVD-ROM drive B DVD-ROM drive to launch the Autodesk 3ds Max 2008 In-

stallation DVD.

Network B ATCP/IP-configured network is required for use in network
rendering, is needed to access the internet for tasks such
as downloading support installs, and is needed for network
licensed setups.

Sound card and
speakers (Optional)

Required for listening to audio tracks.

Software Requirements

Certain softwares are required while others are optional.

Software Require-
ments

Internet Explorer® 6 W To activate and register Autodesk 3ds Max and to view the
(or later) Autodesk 3ds Max Help, you must have Internet Explorer®
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Software Require-
ments

6 (or later). You can download Internet Explorer from the
Microsoft Web site: http://www.microsoft.com/windows/ie/

DirectX® Updates Both DirectX 9.0c and DirectX 10 (Vista only) are supported.

B For DirectX 9.0c you must at least have the original version
of DirectX 9.0c from Microsoft. If you have Windows XP
SP2, you should already have it installed.

B For DirectX 10 you must have DirectX 10 and all of the
updates from Microsoft. If you are running Windows Vista,
you should already have these items installed.

B When you install Autodesk 3ds Max, a specific set of Direct
3D updates is installed for DirectX 9.0c (June 2007, Decem-
ber 2006, and October 2006) and for DirectX 10 (June 2007
and December 2006). These updates make it possible for
DirectX to work with Autodesk 3ds Max.

B You can download the latest version of DirectX (for DirectX
9.0c or 10) from http://www.microsoft.com/DirectX. Click
Download the Latest DirectX.

MSI 3.1 B Needed to run the installer.

Acrobat® Reader® 8 B You will need Acrobat Reader to view all of the PDF docu-
ments on the Autodesk 3ds Max 2008 Installation DVD.

W If you do not have Acrobat® Reader® installed, you can go
to the Adobe Web Site at http://www.adobe.com/products/ac-
robat/readstep2.html

Adobe® Flash Player ~ m Adobe® Flash Player is required to view the Hot Key Map
(available from the Help menu).

B If you do not have Adobe® Flash Player installed, you can
go to the Adobe Web Site at http://www.adobe.com/prod-
ucts/flashplayer/

Software Requirements | 9
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Software Require-

ments

QuickTime® 7 You need QuickTime® 7 to view the Essential Skills Movies and
the New Features Movies. If you try to view a movie without it
installed, you will be prompted to install it.

.NET 2.0 B Installed automatically when you install Autodesk 3ds Max.

Optional Software

OpenGL® B If your graphics card supports OpenGL you will need to
install the OpenGL driver that comes with your card. For
more information see http://www.opengl.org.

Java Runtime Environ- B You will need this download to use the JSR Viewer (M3G
ment Download Player) which you access from Programs > Autodesk > Au-
todesk 3ds Max 2008> |SR Viewer.

Autodesk 3ds Max 32- or 64-bit Support

When you install Autodesk 3ds Max the installer detects whether your machine
is 32- or 64-bit. On a 64-bit machine with a 64-bit operating system you have
the option of installing either 32- or 64-bit Autodesk 3ds Max. The following
illustration summarizes the various combinations of Autodesk 3ds Max
available.

10 | Chapter 2 Installing Autodesk 3ds Max
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Possible Configurations of Autodesk 3ds Max

32-bit 64-bit
Machine Machine
I I . 1
32-bit 32-bit 6.4-bit
Operating Operating Operating
System System System
I I - : ]
32-bit 32-bit 64-bit 32-bit
ersion of Version of Version of Version of
3ds Max 3ds Max 3ds Max 3ds Max
Installed to

YProgram Files (x86)

Calculating the Appropriate Swap-File Setting

A good rule to keep in mind for configuring the size of your Windows swap-file
is to have three times the amount of physical memory (RAM) on your system.
Depending on scene complexity, more swap space might be desirable. When
you output to high-resolution film or print work, the demands will be much
higher than for video resolutions. This is especially true when using Image
Motion Blur.

Many users dedicate entire hard drives or partitions as swap-files. Setting
swap-files in this manner avoids any fragmentation of the swap-file.

It is very important that you have sufficient swap space set aside. A common
cause of system instability is an improperly sized swap-file.

Two Installation DVDs

Autodesk 3ds Max 2008 ships on two DVDs.

B DVD 1 of 2: Software, Documentation, Videos, & Tutorials. (Referred to
as DVD 1 throughout the documentation.)

Calculating the Appropriate Swap-File Setting | 11



B DVD 2 of 2: Autodesk® Vault & Sample Files (Referred to as DVD 2
throughout the documentation.)

On DVD 1 you will find the main software install, plus required installs and
most of the optional installs. On DVD 2, as the name indicates, you will find
Autodesk® Vault and the Sample files.

NOTE The Autodesk Vault Plug-ins are found on DVD 1. The Autodesk Vault 2008
Server and Client are found on DVD 2.

Administrative Permission Requirements

To install Autodesk 3ds Max, you must have administrator permissions. You
do not need to have domain administrative permissions. See your system
administrator for information about administrative permissions.

You will need these permissions to:
Activate Autodesk 3ds Max
Install the Autodesk 3ds Max package.

|

|

B Install network-rendering services.

B Remove Autodesk 3ds Max or any of its components.
|

Import and export your Autodesk 3ds Max license with the Portable License
Utility.

To run Autodesk 3ds Max, you do not need administrator permissions. You
can run the program as a limited-rights user.

Locating Your Autodesk 3ds Max Serial
Number
Your serial number is located on the outside of the product package. When
you are activating Autodesk 3ds Max, you are prompted for your serial number.

Make sure to have this number available for activation. Record this number
and keep it on hand.
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NOTE The serial number will also be required for your next upgrade, if you ever
have to reinstall or reactivate the software, or if you need to contact support.

Serial Number for the Autodesk Store Download

If you purchased the electronic version of Autodesk 3ds Max 2008 from the
Autodesk Store (online store), you find your serial number in both the “Thank
You for Purchasing Autodesk 3ds Max 2008” email and the follow-up email.

Closing Other Programs During Installation

The Autodesk 3ds Max installation process may stop if some applications (such
as Microsoft® Outlook® or virus-checking programs) are running. Close all
running applications to avoid possible data loss.

Additionally, ensure that none of the following programs are running:
Autodesk® 3ds Max®, AutoCAD®, Autodesk® Combustion®, or Autodesk®
VIZ.

The Autodesk 3ds Max 2008 Installation
Wizard

The Installation Wizard contains all installation-related material in one place.
From the Installation Wizard, you can also access user documentation and
view support solutions.

A Quick Installation Wizard Tour

When you insert the Autodesk 3ds Max 2008 Installation DVD in your drive
you will see this main installer page:

Serial Number for the Autodesk Store Download | 13
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Autodesk® 3ds Max® 2008 3ds Max 2008

Installation Wizard

Install Products

== Parfon & standand inslallsnon on this woekstation

Create Deployments
Craate pre-configurad deploymants to install products on
client workstabons.

» # Install Tools and Utilities
S Install network license ullfes, administrative and reporting
bools.

Views the fleerdne £t

NOTE If Autorun does not start the Autodesk 3ds Max 2008 Installation Wizard,
navigate to your DVD-ROM. Click the Setup.exe file to open the Installation Wizard.

The Main Installation Wizard Menu

The Main Installation Wizard menu has three options:

B Install Products—Click to install Autodesk 3ds Max. Certain required
software such as Autodesk Backburner is also installed from this section.

B Create Deployments—Click to create an administrative image of Autodesk
3ds Max which will be deployed to multiple workstations. You do not need
to visit this section if you are simply installing Autodesk 3ds Max on a
single machine. Generally, these administrative images are created by a
system administrator. Before creating the image, read the Autodesk 3ds Max
2008 Network Administrator’s Guide to learn about deploying Autodesk 3ds
Max.

B Install Tools and Utilities—Click to install available supplementary, optional
softwares. For details on these tools and utilities see Supplemental Tools
and Utilities on page 43 .
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Documentation and Support

Documentation and Support links are located in the bottom-left corner of the
Installation Wizard.

Documentaktion
Support

Install and Help File Documentation Set

You can view the entire install documentation set from the Documentation

link in the Installation Wizard. This link is located in the bottom left corner
of all tabs of the Installation Wizard. You also have access to these documents
on the Autodesk 3ds Max 2008 Installation DVD in the \Docs folder.

NOTE The install documentation set is not installed with Autodesk 3ds Max 2008.

It is recommended that you read the 3ds_Max_readme.rtf and this Autodesk 3ds
Max 2008 Installation Guide before beginning the install.

The following table summarizes the install documentation set for Autodesk
3ds Max 2008:

Name of Document

File Name

For Information About:

Autodesk 3ds Max
2008 Readme

3ds_Max_readme.rtf

Late-breaking information relat-
ed to this version of Autodesk
3ds Max 2008 including net-
working issues.

Autodesk 3ds Max
2008 Installation Guide

3ds_Max_sig.pdf

Installing Autodesk 3ds Max
2008.

Autodesk 3ds Max
2008 Network Admin-
istrator’s Guide

adsk_nag_3ds_Max.pdf

How to create an administrative
image and distribute it to multi-
ple users.

Stand-Alone Licensing
Guide

adsk_slg.pdf

Setting up standalone licenses.
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Name of Document

File Name

For Information About:

Network Licensing
Guide

adsk_nlg.pdf

Setting up network licenses, in-
cluding FLEXIm licensing.

SAMReport-lite™ User’s
Guide

Samlite_ug.pdf

SAMReport-lite which is a report-
ing tool that helps you track
network license usage.

mental ray - Produc-
tion Shader Library

mr.production.shaders.pdf

mental ray documentation for
use with a set of specialized
shaders. These specialized

mental ray Architec-
tural and Design Visual-
ization Shader Library

mr.architectural.shaders.pdf

shaders are meant for users that
are performing complex com-
positing and rendering passes.

NOTE Autodesk does not pro-
vide technical support for these
shaders, even if they are used
in Autodesk 3ds Max.

A full set of help files is also included with Autodesk 3ds Max 2008. Typically
you access these files through the Help menu in Autodesk 3ds Max. You also
have access to the help files from the Start menu. (Start > Programs > Autodesk

> Autodesk 3ds Max 2008 [32- or 64-bit] > Help

For a description of all of the documents related to Autodesk 3ds Max see the

“Autodesk 3ds Max Documentation Set” topic in the Autodesk 3ds Max Help
available from the Help menu in Autodesk 3ds Max.
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Support Resources for Autodesk 3ds Max 2008

This page provides links to Autodesk 3ds Max support resources available on
the web.

Documentation
Support

Installing Autodesk 3ds Max

This section contains information for installing Autodesk 3ds Max on a single
workstation. You must have administrative permissions to install Autodesk
3ds Max. During your installation you will either select Standalone or Network
License, depending on the type of license you purchased.

To perform a default Autodesk 3ds Max 2008 install:

1 Insert DVD 1 of 2: Software, Documentation, Videos & Tutorials.

NOTE If Autorun does not start the Autodesk 3ds Max 2008 Installation
Wizard, navigate to your DVD-ROM. Click the Setup.exe file to open the
Installation Wizard.

2 Click Install Products on the Main Menu.
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Imstallation Wizard

Install Products

=0 Parform & standand installanon on this worksttion

. Create Deployments
Craate pre-configured deploymants 1o install products on
elien workstabons.

» # Install Tools and Utilities
g Install netevork lense WIRes, administatve and repcring
Bols.

Views the leedne et

3 From the Welcome to the Autodesk 3ds Max 2008 Installation Page you
can view Autodesk 3ds Max 2008 Installation Guide. When you have
finished reviewing this information, click Next.

4 On the Readme/Samples and Tutorials page you can:
B Click View Readme to view late-breaking information for this release.
B Click View Tutorials to open the folder of tutorial scene files that you

can copy to your computer. Use these scene files to complete the
tutorials (found in the Help menu of Autodesk 3ds Max 2008).

NOTE The Sample files are on DVD 2. See Optional Tools Installed from
DVD 2 on page 56 .

Click Next to continue with the install.

5 On the Select Products to Install page the entries that apply to your
operating system (32- or 64-bit) are selected for install. For a 32-bit OS
only the 32-bit options are selected by default whereas for a 64-bit OS,
all options, including 32-bit options are selected. If you have already
installed any of the components listed, these items will not be marked
for install.

NOTE To not install Autodesk 3ds Max 2008, you need to first turn off all
other items. With all other items turned off, it is possible to turn off Autodesk
3ds Max 2008.

18 | Chapter 2 Installing Autodesk 3ds Max



The following items are selected for install by default:
Autodesk 3ds Max 2008 [32- or 64-bit]

Autodesk 3ds Max 2008 [32- or 64-bit] Additional Maps and Materials
Autodesk 3ds Max 2008 [32- or 64-bit] Architectural Materials
Autodesk 3ds Max 2008 [32- or 64-bit] Help

|
|
|
]
B Autodesk 3ds Max 2008 [32- or 64-bit] Vault 2008 Plug-ins
B Autodesk 3ds Max 2008 [32- or 64-bit] Vault 5 Plug-ins

B Autodesk 3ds Max 2008 [32- or 64-bit] Videos

B Backburner 2007.1 [32-bit but 64-bit compatible]

|

Turbo Squid Tentacles [32-bit only]

NOTE If you have an older version of Autodesk Backburner or Autodesk Vault
plug-in you will be prompted to uninstall them.

Select the Products to Install

W aucodesk® 3ds Max® 2008 32-bit
Audodesk® 3ds Mavo® 2008 32-bi requires DWF Viewer,

¥ 3ds Maa® 2008 32-bit Help

¥ 3ds Mase® 2008 32-bik Addbional Maps and Materials
¥ 3ds Man® 2008 32-bik Architectural Materials

¥ iutodesk® vault 2008 Plugin for 3ds Max® 2008 32-bit
¥ Autodesk® Yault 5 Plugin For 3ds Max® 2008 22-bit

¥ Turbo Squid Tentacks For 3ds Max® 2008 {32-bit only)

¥ Autodesk® 3ds Max® 2008 &4-bit
Autodesk® 3ds Mace® 2008 64-bit requires DVWF Viewer.

=

If you do not want to install a certain product, turn off the corresponding
toggle. Notice that Autodesk Backburner 2007.1 must be installed with
Autodesk 3ds Max 2008. You can install the Autodesk Vault 2008 or Vault
5 Plug-in for 3ds Max 2008 from the first DVD but you install the
Autodesk Vault 2008 Server and Client from the second DVD. For
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information on installing the Server and Client see Autodesk Vault 2008
Server, Client, and Plug-In on page 56

Click Next to continue.
7 Review the Autodesk software license agreement for your country or

region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.

NOTE If you do not agree to the terms of the license and wish to terminate
the installation, click Cancel.

8 On the Personalize the Products page enter your details.

NOTE Be precise because you will not be able to change this information

once you begin the install, unless you uninstall and reinstall Autodesk 3ds
Max.

9 On the Review - Configure - Install page you can proceed with the default
install by simply clicking Install. This means that the default values of
Typical install, Standalone License, and Mental Ray Satellite Port on 7506
are selected.

[ Autodeskcs 365 Maxe 2008 SE]|
Autodesk 3ds Max® 2008 3ds Max’ 2008

Installing Compenants

i NET Framerwork Runtme 2 0 Hotit: Autodesk.
B 3ds Max:

- MSIML 6

* Aupsdssiol DVE™ Virwer
 Autodesion Backburme™

» Autodesiol St Macol 2005 X2-bt
* s Maco® 2000 J2-bt Help

® 3uis Ml 2003 3008 Addsensl
Mgt and Maerisis

& oz Mcol 2008 1.6k Archdectarsl
Matsrials

# Vb Services Enhancements 3 0
for McrasoRil NET Runtrms

Deocumsntation [ . 5
Support (3 Cancel ||

To make custom selections, go to the next procedure.

NOTE If you want to install optional tools see Optional Tools on page 49 .
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To specify custom install options:

1

4

With Autodesk 3ds Max 2008 selected on the Review - Configure - Install
page, click Configure.

You now have a tab for each of the applications for install that have
configuration options.
On the Autodesk 3ds Max tab you can set the license type to:

Standalone License—See Standalone Licenses (Regular and Multi-Seat)
on page 30 .

Network License—See Network Licenses on page 32 .

[ Autodeskn 3as Maxe 2008 BE |

Autodesk® 3ds Max® 2008 3ds Max 2008

Installasion Wizard

(B Autodoskt 3ds Maw 2008 32 bit = | |sAutadeski DWE™ Views:| |5 i |
Infarmation Select the License Type E
(@) Zand-shore boenes
O etk kv
Cordiguration progress:
EREE et
Documentation (3
S © b

On the Autodesk 3ds Max and Autodesk Backburner tabs you can set the
location of the install. To learn more about Autodesk Backburner, see
Autodesk Backburner 2007.1 (with UAC Off for Windows Vista) on page
44 .

Click Next to continue.

On the Autodesk 3ds Max tab there are several other selections you can
make. Next choose between two types of installs:
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Autodesk® 3ds Max® 2008 3ds Max 2008

Installasion Wizard

| Bnutodesk 3ds Mawe 2008 32 bk = | [ Autodesk® DWE™ Viewss) | E =]
Infermation Select the Installation Type ﬁ
@ Irpiesd
Otusten
Product retal pathe

CeiPraqiam Files! Autoded s Max 2008,

Dk $pace requirements:
Vo, Dk Soe | Avalsble | Requred  TotelRequred | Remaning |~
[= [T WM 106G

[ 05T 41668 Obtes 0O bytes 41660

3 120TE LG Obytes 0 bytes 20168
P 19968 ESTGE  Obyles 0 brytes EETGE [w
Confiquration progress:
IR oo tt
Docunertation [

e e

B Typical—Accepts the default installations.

B Custom—It is recommended that you select Typical since the only
Custom option you have is to not install the desktop shortcut. It is
simpler to delete the Desktop Shortcut on the desktop after the install
if you do not want it.

On this page you also can change the location of the Autodesk 3ds
Max install.

When you have finished, click Next.

6 On the mental ray Satellite tab you can change the Satellite TCP port
used for mental ray rendering. See mental ray Satellites on page 23 .
Click Next when you are finished.

7 When you have finished with all changes to the install settings for
Autodesk 3ds Max and Autodesk Backburner, click Configuration
Complete.

8 Click Install to complete this customized installation.
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Autodeskcd 3ds Maxe 2008 3ds Max’ 2008

Installing Compenamts
i NET Framerwork Runtime 20 Hotfi: Autodesk.
* Denctl Furtie Lpdate

* MIIML B

* Aokl DVE™ Virwer

& dufodesioh Baciiumer™

* Aupodesiof Jds kel 2008 3208
* s Mo 2000 320 ek

® s Ma 2008 3008 AddBensl
Mgt and Materinis

* 35 Max 2000 3204 Archiechasl
Matarials

» Vit Services Entanecements 31
Tor Microsofih NET Funtims

NOTE The status bar indicates that the install is in progress, but does not
indicate the percentage of the install that has completed.

9 C(Click Finish to Exit the Installation Wizard.

NOTE If you want to install optional tools see Optional Tools on page 49 .

mental ray Satellites

A port is selected by default for mental ray® network rendering. If the default
value does not suit your needs, you can change it to any numerical value
between 1 and 65535 but you should do so with caution. Speak with your

system administrator before assigning a new number. You can reset to the
default value by entering O in the port field.
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Interrupting the Install Process

You can interrupt the install process by clicking Cancel during the installation.
You then have the option of resuming the install or exiting. If you exit the
installation midway through, you can install the application at another time.
You will be prompted to click Finish to exit the Installation Wizard.

NOTE When you interrupt the install some items which were already installed are

removed. Therefore it may take some time before you can quit the Installation
Wizard entirely.

Leaving Ports Open

Autodesk 3ds Max, Autodesk Vault, Autodesk Backburner, and various other
components of the Autodesk 3ds Max install, require that certain ports be
open in third-party firewalls. If you are having problems with your firewall,
read the documentation included with your firewall.
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Starting Autodesk 3ds Max

You can start Autodesk 3ds Max using any of the following methods.

B Desktop shortcut icon. When you install Autodesk 3ds Max, an Autodesk
3ds Max 2008 shortcut icon is placed on your desktop unless you cleared
that option during installation. Double-click the Autodesk 3ds Max 2008
icon to start Autodesk 3ds Max.

B Start menu. On the Start menu, click All Programs (or Programs) > Autodesk
> Autodesk 3ds Max 2008 [32- or 64-bit] > Autodesk 3ds Max 2008 [32- or
64-bit].

B Location where Autodesk 3ds Max is installed. If you have administrative
permissions, you can run Autodesk 3ds Max in the location where you
installed it. If you are a limited-rights user, you must run Autodesk 3ds
Max from the Start menu or from the desktop shortcut icon. If you want
to create a custom shortcut, make sure that the Start In directory for the
shortcut points to a directory where you have write permissions.

Viewing the Essential Skills Movies

When you launch Autodesk 3ds Max 2008 for the first time, the Essential
Skills Movies splash screen appears. You need QuickTime 7 to view these
movies. When you click to view a movie, you will be prompted to install it if
you have not already.
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Starting Autodesk 3ds Max with Command Line
Switches
You can start Autodesk 3ds Max with special settings using command line

switches. To see a complete list of command-line switches and their functions,
see “Starting 3ds Max from the Command Line” in the Autodesk 3ds Max Help.

NOTE You may need to activate the program before you can use these commands
to start it.

To run Autodesk 3ds Max using a command-line switch:

1 Right-click the icon for Autodesk 3ds Max or its shortcut.

A shortcut menu appears.

2 Choose Properties.
The Properties dialog appears.

3 In the Target text box, add the command-line switch (in this example
-h) after the program path and executable file name. For example:

“C:\Program Files\Autodesk\3dsmax2008\3dsmax.exe” -h

NOTE Ensure the command-line switch is outside of the quotation marks

-

4 Click OK.

The command-line switch takes effect the next time you run the program
from the shortcut.

Registering and Activating Autodesk 3ds Max

The first time you start Autodesk 3ds Max, the Activation Wizard is displayed.
You can either activate Autodesk 3ds Max at that time or run Autodesk 3ds
Max and activate it later. Until you register and enter a valid activation code
for Autodesk 3ds Max, you are operating the program in trial mode. The Register
Today dialog is displayed for 30 days from the first time that you run the
program. If after 30 days of running Autodesk 3ds Max in trial mode you have
not registered and provided a valid activation code, your only option is to
register and activate Autodesk 3ds Max. Once you register and activate
Autodesk 3ds Max, the Register Today dialog is no longer displayed.
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The fastest and most reliable way to register and activate your product is by
using the Register Today dialog, which accesses the Internet. You enter your
registration information and it is sent to Autodesk over the Internet. Once
you submit your information, registration and activation occur almost
instantly.

To register and activate Autodesk 3ds Max

1 Start Autodesk 3ds Max.

2 Inthe Activation Wizard, select Activate the Product, and then click Next.

Autodesk 3ds Max 2008 Product Activation

IMPORTANMT! You are initiating a transaction to modify the terms of your product license.
‘fou must ackivate this product bo complete the transaction.

Whiat would vou like ko da?

& Activate the product
Select thiz option ta start Register Today, where yau can submit an activation request or
enter an activation code you have received from Autodesk.

£ Run the product
Select thiz option to uze the product now.

Lancel

This starts the Register Today process.

3 Click Register and Activate (Get an Activation Code).
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Register Today

B x|

Autodesk

Activation

Product.  Autodesk VIZ 2008
Serial number: - 000-00000000
Request code: KKJ6 TH2C GGSJ W353 TOTT HVY4

Enter your serial number or Group D; @

Select an option below and then click Mext

@ (et an activation code

© Enter an activation cade
Paste the activation code

Type the activation code

You ean also obtain an activation code by visting:
Hitps: Mregister autodesk.com

<< Back | Close Next >>

() Copyright 2006 Autodesk, Inc. &I rights reseryed. Version: 16.0.0.17 - Privacy Policy M

4 Click Next and follow the on-screen instructions.

NOTE You will be prompted to Login to Autodesk. If you do not already
have an account, you will need to create one.

If you do not have Internet access, or if you want to use another method
of registration, you can register and activate Autodesk 3ds Max in one of
the following ways:

E-mail Create an e-mail message with your registration information
and send it to Autodesk.

Fax Enter your registration information, and fax the information to
Autodesk.

Phone Provide your registration information to one of our
representatives over the phone.
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Use the numbers or e-mail address that correspond to your area:

Area e-mail Fax and Phone Num-
bers
United States, authcodes@autodesk.com FAX:

Canada
Latin America

800.225.6490 or
415.507.4937
Phone:
800.551.1490

Europe authcodes.neu@autodesk.com Fax:

Middle East +41 (32) 7239169
Africa

Asia Pacific ap.register@autodesk.com Fax: +65.6735.4857

Types of Licenses

When you purchase Autodesk 3ds Max you purchase a license for a
standalone-licensed version, multi-seat standalone licensed version, or a
network-licensed version. The following section provides information on these
types of licenses.

B For standalone and multi-seat standalone licenses also refer to the Autodesk
Stand-Alone Licensing Guide.

B For network licenses also refer to the Autodesk Network Licensing Guide.

NOTE Access both guides on the Documentation page (bottom-left corner) in
the Installation Wizard of DVD 1.

After activation, you can see which type of license you have, in Autodesk 3ds
Max 2008, select Help > About

NOTE If you are upgrading Autodesk 3ds Max, you do not need the previous
version of Autodesk 3ds Max installed on your system. However, you will need
your previous serial number to obtain a new activation code.
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Standalone Licenses (Regular and Multi-Seat)

For a regular standalone license, when you activate Autodesk 3ds Max, only
the computer you activated it on is licensed to run that copy of the program.
The license is bound to that machine.

For a multi-seat standalone license you use a single serial number for multiple
computers. The license is installed locally on each machine, and works for a
specific number of seats. The number of activations for the serial number is
tracked up to the maximum and then no additional Autodesk 3ds Max sessions
can be run.

In both cases, you license Autodesk 3ds Max during the activation process as
described in Registering and Activating Autodesk 3ds Max on page 26 .

For complete information about standalone licenses, read these standalone
licensing sections along with the Autodesk Stand-Alone Licensing Guide available
on the Documentation page (bottom-left corner) in the Installation Wizard
of DVD 1.

Updating or Moving your Autodesk 3ds Max
License

If you make changes to your computer, or if you install Autodesk 3ds Max on
a new computer, you need to take steps to ensure that you do not receive
license errors. You can use the Portable License Utility (PLU) to export the
license from your system. Changes that will require the use of the PLU include
changing the main hard disk, the motherboard, or upgrading the BIOS.

NOTE Just adding memory or changing the video card does not require
reactivation.

The license information is not removed when you uninstall the software
following a standard uninstall process. If you reinstall on the same system,
the Autodesk 3ds Max license information is still valid. You do not have to
reactivate or use the PLU.
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Portable License Utility

Your Autodesk 3ds Max license is valid on only one computer at a time. With
the PLU, you can transfer the license to another computer or transfer it back
to the original computer. The Portable License Utility help (adsk_plu.chm) can
be found in \Program Files\Common Files\Autodesk Shared\ENU

To transfer a license to another computer using the PLU:

1 To launch the Portable Licensing Utility select Start menu > Programs >
Autodesk > Autodesk 3ds Max 2008 > Portable Licensing Utility

2 Click Add to add the other Computer name and Identification code, then
click Ok. The Export License dialog opens.

3 Go to the Licenses page and click Export License.

4 A license transfer file must be used the first time a license is exported.
Click Transfer License.

5 From the other computer, run the PLU, and click Import License then
browse to import the file you just created.

To temporarily transfer your license while changing your system:
1 Follow step 1 and 2 from the previous procedure.

2 On the Export License dialog change the destination path to your external
device such as a flash drive or floppy.

3 Click Transfer License.
4 When the changes on your machine are completed, run the PLU and

reimport the license onto your computer from the external device.
For more information about using the PLU, click Help on the PLU dialog.

Grace Period for an Emergency License

After the license has been moved to another computer, the Portable License
Utility has a twenty-four-hour grace period, during which time you can run
Autodesk 3ds Max on the source computer. When the grace period expires,
the source computer cannot run Autodesk 3ds Max again until you complete
a “round trip” of the license: once you have moved the license to the target
computer, you need to move it back to the source computer. The grace period
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may not be available if you have recently used the emergency license on the
source computer.

Converting a Standalone License to a Network
License

A standalone license can be converted to a network-license. Check with your
Authorized Autodesk Reseller for more information. To locate your reseller go
to: http://www.autodesk.com/reseller.

Network Licenses

If you've purchased a network-licensed version of Autodesk 3ds Max, network
administrators can perform a network installation by installing the Autodesk
License Manager tools. Refer to the Autodesk Network Licensing Guide available
on the Documentation page (bottom-left corner) in the Installation Wizard
of DVD 1.

Network-licensed versions of Autodesk 3ds Max obtain activation from a
network-license server.

Contact your Authorized Autodesk Reseller if you want to get a network license.
See http://www.autodesk.com/reseller.

License Borrowing

If you are running Autodesk 3ds Max on a laptop, you can use the License
Borrowing Utility to check-out a license when you are not connected to the
network. For a complete explanation of license borrowing, see the Network
Licensing Guide. You can also refer to the acad_brw.chm, installed in the \Program
Files\Common Files\Autodesk Shared\ENU folder on your local drive.

System Date and Time

In a network licensing setup the license server will not work if the system date
and time have been tampered with, either intentionally or by mistake. To fix
the problem set the clock back to the correct time and the license server will
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be unlocked. You will need to buy a new license if your license has expired.
Permanent network licenses are not bound to a clock.

Graphic Display Drivers

When you launch Autodesk 3ds Max, the Direct3D (DirectX) graphics driver
is chosen by default. If you have DirectX 9.0c then DirectX 9.0 is selected. If
you have DirectX 10 (Vista only), then DirectX 10 is selected. You can try the
different drivers if you are not sure which option gives you the best
performance. Choose Windows Start > Programs > Autodesk > Autodesk 3ds
Max > Change Graphics Mode.

Direct3D Driver Setup

r DirectaD Yersion
@ Directx 9.0

£ Direct< 10.0

r DirectaD Device
@ Hardware [HAL]
= Software [FefRast]

r Direct3D Use Flags
® Release
" Debug

Revert from Direct3D ... |

Ok | Cancel |

Once you find a driver that gives you the best performance, start Autodesk
3ds Max using your normal shortcut. Find information about all the driver
options in “Graphics Driver Setup Dialog” in the Autodesk 3ds Max Help.

Checking for Graphics Card Updates

It is recommended that you verify and update your graphics card driver to
optimize your program. Use the following procedure to identify your current
graphics card driver.

To check if new drivers are available (Windows, not Vista)

1 On the Start menu, click Settings > Control Panel.
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Click the Display icon to access the Display Properties.
Open the Settings tab and click the Advanced button.
Click the Adapter tab to check the adapter type.

Click the Properties button and open the Driver tab to check driver version
and see if newer drivers are available.

(Multiple Monitors) and NVIDIA Quadro FX 2500M Pro... |2 |3

Cobo Managesment &3 Quadio FX 2500M
General Adapler Monitor Troubleshoot
Adapter Type

@ NIDLA Quadko FX 25008

Adapter Information

Chip Type: Quadro Fx 250084
DAL Type: Integiated RAMDAL
Mernoy Size: 512MB

dudapter Sting:  Quadio FxX 25006
Bios Information:  Yersion 5.71.22.28.04

List Al Modes...

To check if new drivers are available (Windows Vista, Classic View)

1

wn A W N

On the Start menu click Control Panel.

Click Personalize.

Open Display Settings and click Advanced Settings.
Click the Adapter tab to check the adapter type.

Click the Properties button and open the Driver tab to check driver version
and see if newer drivers are available.
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NVIDIA Quadro FX 3000 (Microscft Corporation - WDDM) P... i@‘

Genuﬂ Diiver .Detalslﬂesoum_

E MVIDIA Guadm EX 3000 (Microsoft Corporation -
WODM)

Driver Provider: ~ NVIDIA

Driver Date: B/21/2006

Driver Version: 7.14.10.9686
Digital Sigrer: microsoft windows

Driver Detais To view details about the driver files

| Update Driver... | Toupdate the driver software for this device

¥ the device fails after updating the driver, rol
back to the previously installed driver.

Disable | Disables the selected device.

2 To unnstall the diver (Advanced)

oKk ][ Conced |

NOTE Graphics driver information is also viewable within Autodesk 3ds Max from
Customize menu > Preferences > Preference Settings dialog > Viewports tab.

TIP Many newer graphic cards offer tabbed pages where you can learn more
precise information about your specific graphic card. If specific tab pages are
present, refer to them instead of the Adapter tab.

Reinstalling or Repairing Autodesk 3ds Max

If you accidentally delete or alter files that are required by Autodesk 3ds Max,
you may receive error messages when you try to execute a command or find
a file. You can usually fix the problem by reinstalling or repairing Autodesk
3ds Max. The reinstallation or repair uses the features that were part of the
installation type you chose when you initially installed the program. You may
need the DVD for reinstallation and repair.

NOTE The procedures differ between Vista and other Windows operating systems.

The following are the components related to Autodesk 3ds Max that you will
find in the list:

B Autodesk 3ds Max 2008 [32- or 64-bit]
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Autodesk 3ds Max 2008 [32- or 64-bit] Additional Maps and Materials
Autodesk 3ds Max 2008 [32- or 64-bit] Architectural Materials
Autodesk 3ds Max 2008 [32- or 64-bit] Help

Autodesk 3ds Max 2008 [32- or 64-bit] Vault 2008 Plug-ins

Autodesk 3ds Max 2008 [32- or 64-bit] Vault 5 Plug-ins

Autodesk 3ds Max 2008 [32- or 64-bit] Videos

Backburner 2007.1 [32-bit but 64-bit compatible]

FBX Plug-in for Autodesk 3ds Max 2008

Turbo Squid Tentacles [32-bit only]

NOTE When repairing Autodesk 3ds Max, make sure that you have exited the
program and make sure it is not running in a minimized state. If an existing file is
newer than a file normally used to repair it, the existing file isn’t changed. In other
words, if you’ve applied a patch, a repair will not restore the system to a
pre-patched state.

To reinstall or repair Autodesk 3ds Max (Windows, not Vista)

1 Select Start menu > Control Panel > Add or Remove Programs.

2 In the Add or Remove Programs window, select Autodesk 3ds Max 2008.

| "5 had or Remave Programs [M(=1% |
—1
il Cusmently instaled prograns: [] show upgates Sort by: | Name |
Change e 7 A Tk Sytewerization Agerk Sze 031N [a
Remmowe
Progams 33 tpple Software Updste Sz ZASME
= (2] Austodesk 3ds Mas 2008 32-bat See  35.00ME
¥ el ot ofomtin et s
ek e
e Last Usad On - 8/13/2007
" computer, cick Change or Remave,
g @Mmmmm}?k Addiional Maps and Material Lbraries Ske 91.03M8
AddRemove [ o rodest: 3ds Mae 2008 32-bk Archiectural Materials Libeary Sice  142,00MB
Componants () . podesk: 3ds M 2008 X258 Help Sice 120,.00M8
@ [ tuodesk: 3ds Max 2008 32-bk Vauk 2008 Flug-In Sze  0.52ME
Autodesk: 3ds Max 2008 32-bt Yauk S I
=P 2 Phayln Sze 2468
Access Hutodesk: 3ds Max 2008 32-bk ideos @ !
e B Size 108, 00MB
[B) svsodesk: 3ds Max 9 3262 Sze 4560008
a Autodek Buzzsaw 2007.2,1936.13 Sie 21.63M8
B Autodesk: Data Management Server 2008 Sie  123.00M8
(8 Autodesh; Harvaster See 0758
B aubodest: vaul 2008 Se  110.00ME
§5) Backbumer Sue  T.E2ME [w
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You can also reinstall or repair the other components of Autodesk 3ds
Max 2008 using the same procedure, such as the Help or Additional Maps
and Materials. Select the corresponding item from the Add/Remove
Programs list.

The Installation Wizard re-opens in Maintenance Mode.

3 On the Application Maintenance page, click one of the following, and
then click Next:

B Repair—This option replaces all registry entries that Autodesk 3ds
Max initially installed and restores Autodesk 3ds Max 2008 to its
default state. If you are missing Autodesk 3ds Max files, use this option.

B Reinstall—This option repairs the registry and reinstalls all files from
the original installation. Use this option if the Repair My Autodesk
3ds Max 2008 Installation option does not solve the problem.

1%/ Autodesk 3ds Max 2008 32-bit M= x|

Application Maintenance

Select the maintenance operation to perform, Auto desk.

Madify the installstion by adding ard removing components.

Reinstall missing or corupt flles, registy keys, and shortcuts.
Preferences stored in the registiy may be reset to default values.

Uninztall Autodesk 3ds Max 2008 32-bit from thiz complater.

[ Remave logs and configuration files.

Wise Instalation wizard®

[ New> | [ Concal |

NOTE It is not necessary to use the Modify option. The only thing you can
modify separately is the desktop shortcut.

4 Click Next to start the process.

On the Repair Complete page, you are informed when the repairs have
been performed.

5 Click Finish.
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To reinstall or repair Autodesk 3ds Max (Windows Vista, Classic View)

1 Select Start menu > Control Panel > Program and Features

2 In the Uninstall or Change Program window, select Autodesk 3ds Max
2008.

Uninstall or change a program

. select it from the list and then click “Uninstall”, “Change”, or “Repair”,
Organize ||| Views - ¥ Usinstall &k Change b Repair o
Hame : Pulisner .
B austodek 38s Max 2008 32-bit MAX_G0EE Butedek
(B tsutodest: 3ds Max 2008 32-bit MAX_G06H Additional Maps and Matesial Libraries  Autodesk
B sutodesk: 3 Mas 2008 32-bit MAX_GOEH Architectural Materials Libesry utedek
(B sustedieti 3es Max 2008 32-kit MAN_G064 Help Autedeik
(B ustodesic 305 Max 2008 32-bit MAX_G064 Vauh 5 Pugrin utedek
(B sustodesk 3ts Max 2008 32-bit MAX_GO64 Vauk 2008 Phg-In Aubodesk
(B surteden 3ds Max 2008 32-bit MAX_5054 Videor Autiditk
B utedesk Design Fieview 2008 Autedesk, Ine.
FEackbumer Discreet

BB Prugin 2006.11.1 for Mux 2008 -

You can also select other components of Autodesk 3ds Max 2008 using
the same procedure, such as the Help or Additional Maps and Materials.
Select the corresponding item from the list.

The Installation Wizard re-opens in Maintenance Mode.

3 Click Change or Repair:

B Repair—This option replaces all registry entries that Autodesk 3ds
Max initially installed and restores Autodesk 3ds Max 2008 to its
default state. If you are missing Autodesk 3ds Max files, use this option.

B Change— You can use this option to uninstall if you want to see the
progress of the uninstall.

4 Click Next to start the process.

On the Repair Complete page, you are informed when the repairs have
been performed.

5 Click Finish.

Uninstalling Autodesk 3ds Max

Uninstall Autodesk 3ds Max 2008 using Add/Remove Programs (Uninstall or
Change Program in Vista). Several Autodesk 3ds Max components are separate
installs. You need to remove each component separately.
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The following are the components related to Autodesk 3ds Max that you will
find in the list:

Autodesk 3ds Max 2008 [32- or 64-bit]

Autodesk 3ds Max 2008 [32- or 64-bit] Additional Maps and Materials
Autodesk 3ds Max 2008 [32- or 64-bit] Architectural Materials
Autodesk 3ds Max 2008 [32- or 64-bit] Help

Autodesk 3ds Max 2008 [32- or 64-bit] Vault 2008 Plug-ins

Autodesk 3ds Max 2008 [32- or 64-bit] Vault 5 Plug-ins

Autodesk 3ds Max 2008 [32- or 64-bit] Videos

Backburner 2007.1 [32-bit but 64-bit compatible]

FBX Plug-in for Autodesk 3ds Max 2008

Turbo Squid Tentacles [32-bit only]

NOTE Certain files are left on your system after you uninstall Autodesk 3ds Max
2008. For information on removing these files, refer to the Autodesk 3ds Max 2008
Readme.

To uninstall Autodesk 3ds Max (Windows, not Vista)

1 Select Start menu > Settings > Control Panel > Add or Remove Programs.

2 In the Add or Remove Programs window, select the item that you want
to remove, and then click Remove.
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NOTE If you remove the FBX Plug-in a separate window will open and you
will need to click Uninstall. When the uninstall is complete, click Close.

3 When informed that the component has been successfully uninstalled,
click Finish.

4 Repeat with any other Autodesk 3ds Max components that you want to
remove.

NOTE Even though Autodesk 3ds Max is removed from your system, the software
license remains. If you reinstall Autodesk 3ds Max at some future time, you will
not have to register and re-activate the program.

To uninstall Autodesk 3ds Max (Windows Vista, Classic View)

1 Select Start menu > Control Panel > Program and Features

2 In the Uninstall or Change Program window, select Autodesk 3ds Max
2008.
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Uninstall or change a program
o uninstall 8 program, select it from the st and then click “Uninstall”, “Change’, or “Repar”.
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You can also select other components of Autodesk 3ds Max 2008 using
the same procedure, such as the Help or Additional Maps and Materials.
Select the corresponding item from the list.

The Installation Wizard re-opens in Maintenance Mode.
3 Click Uninstall.
4 Follow the prompts.
5 Click Finish.
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Supplemental Tools and
Utilities

You can install many supplemental tools and utilities from the Autodesk 3ds Max 2008
Installation Wizard. Some of these tools and utilities are required while others are optional.
This chapter describes each of the supplementary tools, including how they are installed.

Required Tools and Utilities

Autodesk Backburner 2007.1, .NET and Direct X 9.0c and 10 updates are installed
by default during the Autodesk 3ds Max installation.

If you have already installed the required version of any of these tools or utilities,
they will not be selected for install. If you have installed an older version of
Autodesk Backburner you will be prompted to uninstall it before continuing.
Also see Network Licensing Tools (Required for Network Licensing) on page
52.

.NET 2.0

.NET is required for Autodesk 3ds Max, MAXScript, and Vault and is
automatically installed when you install Autodesk 3ds Max. .NET ensures the
proper communications between the different components of the Autodesk 3ds
Max install and also makes it possible to create .NET objects with MAXScript.
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Web Services Enhancements 3.0 for Microsoft
NET Runtime

These enhancements are installed to improve the performance of .NET.

DirectX 9.0cand 10

For DirectX 9.0c you must at least have the original version of DirectX 9.0c
from Microsoft. If you have Windows XP SP2, you should already have it
installed.

For DirectX 10 you must have DirectX 10 and all of the updates from Microsoft.
If you are running Windows Vista, you should already have these items
installed.

You can download the latest version of DirectX (for DirectX 9.0c or 10) from
http://www.microsoft.com/DirectX. Click Download the Latest DirectX.

When you install Autodesk 3ds Max, a specific set of Direct 3D updates is
installed for DirectX 9.0c (June 2007, December 2006, and October 2006) and
for DirectX 10 (June 2007 and December 2006). These updates make it possible
for DirectX to work with Autodesk 3ds Max.

Autodesk Backburner 2007.1 (with UAC Off for
Windows Vista)

Autodesk® Backburner™ is the Autodesk 3ds Max network-rendering
management software, also used by products such as Autodesk® Combustion®
Autodesk® VIZ® , Autodesk® Flame® , and Autodesk® Smoke® . Autodesk
3ds Max has been designed to work with Backburner 2007.1. It is installed
during the installation of Autodesk 3ds Max.

If you're installing Autodesk 3ds Max on a system that had installations of
Autodesk VIZ 2006, 2007, and 2008, Autodesk 3ds Max 8 or 9, or Autodesk
Combustion, an older version of Autodesk Backburner is already installed on
the system. You should uninstall previous versions of Autodesk Backburner
before installing the new version. Autodesk Backburner 2007.1 is installed by
default to the following path: \Program Files\ Autodesk \Backburner. Autodesk
Backburner 2007.1 is backward compatible so reassigning older jobs to it is
not a problem.
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For information on using Autodesk Backburner with Autodesk 3ds Max see
the “Network Rendering” section on the Autodesk 3ds Max Help. For further
information about Autodesk Backburner refer to the Autodesk Backburner User’s
Guide and Autodesk Backburner Installation Guide which are available from Start
> Programs > Autodesk > Autodesk 3ds Max 2008 [32- or 64-bit] > Help .

NOTE Autodesk Backburner 2007.1 does not acquire settings from previous
versions of Autodesk Backburner. You must create new settings in Autodesk
Backburner 2007.1.

To turn off UAC on Windows Vista:

1 Go to Start menu > Control Panel > User Accounts > User Accounts

e ) % + Control Panel » User Accounts » ~ | 44 | Seorch &

ol Panel Home

% User Accounts

Change your account picture | @ Give other users access to this computer
1@ Change account type

and Maintenance

k and Internet

\EE Windows CardSpace

Hardwiare and Seund ! Manage Information Cards that are used to log on to online services

Programs

User Accounts @ Mail

Appearance and
Personalization

Clock, Language, and Region
Ease of Access

Additional Options

Classic View

Recent Tasks
[’y Change account type

Uninstall a program

2 Click Turn User Account Control on or off.

NOTE You need to have administrative permissions.
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% » Control Panel » User Accounts » User Accounts

ew Tools Help

Make changes to your user account

Change your picture
@ Turn User Account Control on or off Standard user

® Manage User Accounts

To change your password, press Ctrl+Alt+Del and select Change a Password

3 Turn off Use User Account Control (UAC) to protect your computer.

52, < User Accounts » Turn User Account Control On or Off = | 43 | Search £

File Edit View Tools Help

Turn on User Account Control (UAC) to make your computer more secure

User Account Contral (UAC) can help prevent unautharized changes to your computer. We recommend that
you leave UAC tumed on to help protect your computer.

Use User Account Contral (UAC) to help protect your computer

G

4 Restart your computer.
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Autodesk Backburner 2007.1 for Managing and
Monitoring Only

You can install Autodesk Backburner 2007.1 on a machine without Autodesk
3ds Max or another supported product such as Autodesk VIZ or Autodesk
Combustion. However, such an installation of Autodesk Backburner cannot
be used for rendering. You can only use this machine to manage or monitor
jobs. Although the Autodesk Backburner server can be installed on a single
machine, it will not do anything; it will only work if it detects a supported
program such as Autodesk 3ds Max, Autodesk VIZ, or Autodesk Combustion.
This means that you must have Autodesk Backburner installed with at least
one additional Autodesk product for a machine to render in your configuration.

Installing Required Tools without Installing
Autodesk 3ds Max

Use this procedure to install Autodesk Backburner for managing and
monitoring only. This is useful when you simply want to monitor or manage
jobs from a particular computer, but do not need to render from that computer.

Though not required, you can also install the Autodesk Vault Plug-ins, the
Help, the Additional Maps and Materials, the Architectural Materials, and
Turbo Squid Tentacles using this procedure.

To install required tools without Autodesk 3ds Max:

1 Insert the DVD 1 of 2: Software, Documentation, Videos, & Tutorials.

NOTE If Autorun does not start the Autodesk 3ds Max 2008 Installation
Wizard, navigate to your DVD-ROM. Click the Setup.exe file to open the
Installation Wizard.

2 Click Install Products.

3 Follow the prompts to the Select Products to Install page. By default the
following items are selected for install, unless you have installed
components already:

B Autodesk 3ds Max 2008 [32- or 64-bit]
B Autodesk 3ds Max 2008 [32- or 64-bit] Additional Maps and Materials
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Autodesk 3ds Max 2008 [32- or 64-bit] Architectural Materials
Autodesk 3ds Max 2008 [32- or 64-bit] Help

Autodesk 3ds Max 2008 [32- or 64-bit] Vault 2008 Plug-ins
Autodesk 3ds Max 2008 [32- or 64-bit] Vault 5 Plug-ins
Autodesk 3ds Max 2008 [32- or 64-bit] Videos

Backburner 2007.1 [32-bit but 64-bit compatible]

Turbo Squid Tentacles [32-bit only]

4 To not install Autodesk 3ds Max 2008, you need to first turn off all other
items. With all other items turned off, it is possible to turn off Autodesk
3ds Max 2008.

5 Enable the items you want to install, and then click Next.

Select the Products to Install

7

|»

Auoﬂesxewe ﬁn'a:x;z'uus :32-;:I:eq.ures DWF Viewer,
W 3ds Ma® 2008 32-bit Help

¥ 2ds Maca® 2008 32-bik Additional Maps and Materials

¥ 3ds Ma® 2008 32-bik Architectural Materials

¥ sukodesk® Yault 2008 Plugin for 3ds Max® 2008 32-bit
[ Autodesk® Yault 5 Plugin for 3ds Max® 2008 32-bit

¥ Tubo Squid Tentacles for Jds Max® 2008 (32-bit only)

[T AutodeskB 3ds Maxi® 2008 &4-bit
Aufodesk® 3ds Max® 2005 64-bR requires DWF Viewer,

IE 3ds Max® 2008 64-bit Help

[T 3ds Mac® 2008 &4-bit Architectural Materials

6 On the Review - Configure - Install page you can proceed with the default
install by simply clicking Install.

7 Click Install to complete this default installation.

NOTE If you want to install optional tools see Installing Optional Tools from
DVD 1 on page 57 .

48 | Chapter 3 Supplemental Tools and Utilities



Optional Tools

The following are the optional tools which you install from the Tools and
Utilities menu. The optional tools are either installed by default or installed
from DVD 1 or DVD 2.

Optional Tools Installed by Default

Follow the procedure for Installing Required Tools without Installing Autodesk
3ds Max on page 47 to install the Help, Architectural Materials and Additional
Maps and Materials, and Autodesk Vault 5 and 2008 Plug-ins. These tools are
not required, but you use the same procedure for installing them as the
required tools.

Help

You are strongly encouraged to install the Help item (which is selected by
default when you install Autodesk 3ds Max 2008). By selecting the Help item
you install the Autodesk 3ds Max Help, Autodesk 3ds Max Tutorials, Mental Ray
Reference and MAXScript Reference. These documents provide the help you will
need to gain a full understanding of Autodesk 3ds Max 2008 and its
components.

Architectural Materials and Additional Maps and
Materials

By default the Architectural Materials and Additional Maps and Materials
options are installed. These include several maps and materials which are
installed into your \3ds Max 2008\maps and \material libraries folders. Refer
to the Autodesk 3ds Max Help for information on maps and materials.

AutodeskVault 5 and 2008 Plug-ins (32- or 64-bit)

By default both of the Vault Plug-ins are installed with Autodesk 3ds Max
2008. See Autodesk Vault 2008 Server, Client, and Plug-In on page 56 .
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Turbo Squid Tentacles (32-bit only)

Turbo Squid™ Tentacles is free software you can use to buy and sell digital
assets. It provides access to a strong community of graphics professionals and
a growing library of over 70,000 models, motion capture files, maps, sounds,
plug-ins and more. For more information, visit the Turbo Squid Web site at
http://www.turbosquid.com. It is installed by default during the installation of
Autodesk 3ds Max 2008.

Autodesk 3ds Max 2008 Movies

The Autodesk 3ds Max 2008 New Feature Movies show you some of the latest
improvements in the Autodesk 3ds Max 2008. You can access these movies
from the “What’s New” topic in the Autodesk 3ds Max Help.

Optional Tools Installed from DVD |

Several optional tools are installed from DVD 1.

Tutorials

As you progress through the tutorials (found in the Help menu of Autodesk
3ds Max 2008) you will need various scene files. These files are available from
your Autodesk 3ds Max 2008 Installation DVD and need to be copied to your
machine so that you can use them.

Autodesk Design Review 2008

You use Autodesk Design Review 2008 to view and print 2D and 3D designs
in the DWF file format. For further information see
http://www.autodesk.com/designreview.
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Autodesk 3ds Max 2008 SDK

Information about the Autodesk 3ds Max Software Development Kit (SDK) is
available on our peer-to-peer SDK Forum on the World Wide Web. To visit
the SDK Forum, use the Autodesk Media and Entertainment Online Forum
Web site at: http://www.autodesk.com/3dsmax-sparks.

To install the Autodesk 3ds Max 2008 SDK Help and/or the Max SDK Help for
Visual Studio 2005 follow the instructions for Installing Optional Tools from
DVD 1 on page 57 .

Autodesk 3ds Max 2008 SDK Help

If you install the Autodesk 3ds Max 2008 SDK Help, it is installed in CHM
format in the \maxsdk\help folder under \3ds Max 2008.

Using the SDK, you can create new Autodesk 3ds Max features and tools by
writing your own plug-ins.

Autodesk 3ds Max 2008 SDK Help forVisual Studio
2005

A version of the SDK help has been created that is integrated into the
Microsoft® Visual Studio® environment if you install Autodesk 3ds Max 2008
SDK Help for Visual Studio. You should not select this option for install if you
do not have Visual Studio installed.

NOTE Autodesk 3ds Max 2008 SDK for Visual Studio will not work with the Visual
Studio .NET “Dynamic Help” feature.

To view the Autodesk 3ds Max 2008 SDK Help from inside Visual Studio:
1 Launch Visual Studio.

2 Show the Contents panel.

Notice a new entry on the Contents panel called: 3ds Max 2008 SDK
Help.

3 Expand the 3ds Max 2008 SDK Help entry to view the associated help.
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NOTE You can also select different filters using the Filtered By list in Visual
Studio. This feature allows you to select which part of the SDK help you would
like to have active in the Contents, Index, or Search.

Network Licensing Tools (Required for Network
Licensing)

In a network licensing setup the network administrator needs to install the
Network Licensing Manager and the Network License Activation Utility.

Find full details on network licensing in the Network Licensing Guide
(adsk_nlg.pdf) available on the Documentation page (bottom-left corner) in
the Installation Wizard of DVD 1.

B Network Licensing Manager—The Network License Manager is used to
configure and manage the license servers.

B Network License Activation Utility—With the Network License Activation
utility, you can obtain licenses over the Internet, which saves time and
effort in setting up a network-licensed version of the program. In addition,
you can register your product, get automated support by e-mail if you
cannot obtain a license over the Internet, and save and migrate license
files automatically.

Autodesk CAD Manager Tools 4.0

The Autodesk CAD Manager Tools 4.0 includes Autodesk Product Manager
and CAD Manager Control Utility. These tools help keep your Autodesk
products organized and running with the correct permissions.

Autodesk Product Manager—Autodesk Product Manager searches a network
and reports information about each Autodesk product installed, including
programs, service packs, extensions, and object enablers. You can save the
results of the search in a file for use in a spreadsheet or database application.

CAD Manager Control Utility—Using the CAD Manager Control utility, CAD
managers can selectively control which users have access to Internet-based
content and information from the Communication Center and the
Subscription Center. They can also determine if users receive notification
when reported errors are resolved.
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Starting the CAD Manager Control utility

1 On the Start menu (Windows), click All Programs (or Programs) >
Autodesk > CAD Manager Tools > CAD Manager Control Utility.

2 Select the product you want to modify. Click OK.

SAMReport-Lite

SAMReport-lite is a reporting tool that helps you track network license usage.
You need to obtain a separate license for this tool. Click the Obtain a License
link below the SAMReport-lite entry in the Select the Products to Install page
of the Installation Wizard. Refer to the Autodesk SAMReport-lite User's Guide
available from the Documentation page (bottom-left corner) in the Installation
Wizard of DVD 1.

SaMreport-Lite

Dhtain a license (Regquired to install SAMrepart-Lite)

Autodesk Combustion 4 Trial

A link to the 30-day trial of Autodesk® Combustion® has been included.
Combustion is Autodesk’s desktop compositing solution. Try using it to
complement your Autodesk 3ds Max workflow. For more information about
Autodesk Combustion at http://www.autodesk.com/combustion. A link to the
installer is available on the “Select the Products to Install” in the Install Tools
and Utilities section of the installer.

JRE 1.4.2 (Java™ Runtime Environment)

You will need this download to use the JSR Viewer (M3G Player) which you
access from Programs > Autodesk > Autodesk 3ds Max 2008 > JSR Viewer. A
link to the installer is available on the “Select the Products to Install” in the
Install Tools and Utilities section of the installer.
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QuickTime® 7 Download

You need QuickTime® 7 to view the Essential Skills Movies and the New
Feature Movies. If you try to view a movie without it installed, you will be
prompted to install it. A link to the installer is available on the “Select the
Products to Install” in the Install Tools and Utilities section of the installer.

Partners/Plug-Ins

Autodesk 3ds Max includes several partner plug-ins.

WARNING You need to install Autodesk 3ds Max 2008 and also run it at least
once before installing these plug-ins. This will improve the compatibility of the
plug-ins with Autodesk 3ds Max 2008. In the case of Turbo Squid™ Tentacles,
which is installed at the same time as Autodesk 3ds Max 2008, you only need to
make sure you open Autodesk 3ds Max 2008 at least once before opening Turbo
Squid™ Tentacles.

B RPC™ Plug-Ins from ArchVision™, Inc.— Lets you add photorealistic objects
(such as cars, people, etc.) from the included ArchVision sample CD to
your renderings.

ARCHVISION. Welcome to the InstallShield Wizard for RPC Plug-in for 3ds Max 2008
archrmoncom

d vell install RiPC Plugrn for 3ds Max 2008 on your computer. To

Insallfi | — | T |

B EASYnat™ from Bionatics® s.a.—Offers a lifelike plant modeling solution
that allows you to drop virtual seeds from the included samples and “grow”
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them in your model. Create 2D, 3D, and hybrid models that include branch
and leaf detail.

EASYnat for 3ds Max 2008

Welcome to Bionatics setup.
Sedect the: program you wich to nn m“td

Iheee hees, apne, 2

|muEA5Ynsr251uhee’:\dstu working with the B plants included
n\sr& o “You muest install 3cks Maw 2008 prion b istaling EAS Vst

Leam more about EASnal
Dscover the benefits of Bionatics' technology in thes dlustrated showcase.

Tiy nstF : the advanced 30 plant models fos high-end visuslsation,
animation and video game
[Bianatics best know-how in plant modelrg.

Wisk v bionatic . com and upgrade vour rusety onvine with more
3 res: Ihan 300 plants fom &l around the world

e =

B Okino PolyTrans™ and NuGraf™ Demos— A demo version of PolyTrans
and NuGtaf, from Okino Computer Graphics, lets you evaluate dozens of
CAD, DCC and VisSim data converters directly within Autodesk 3ds Max.

NOTE You need to also install the Okino Plug-ins Demo to access PolyTrans
and NuGraf from inside Autodesk 3ds Max.

Welcome to the ‘MuGraf [x86)" and "PolyTrans
[xBB)' setup program [demo versions).

This program will install sither Oking's NuGraf [x86) oo
PolyTrans [x86) on your computer,

Itis strongly recommended that you exit all wWindows
programs before using this Setup Program. PLEASE
DISABLE ALL SPYWARE AND ANTIVIRUS
PROGRAMS [may interfere with b5 XML installation].

Chck. Cancel to quit Setup and close any programs you
have unning. Click Nest to conlinug witk the Setup.

WARMIMG: Thiz program is protected by copyright law
and international eaties.

Unauthorized rsouoducluon o digtibution of this program,
of any partion of &, may result in severe civil and criminal
penalties, and will be prozecuted to the maximum extent
possible under the lav.

< Back

B Okino PolyTrans™ Plug-ins — Makes it possible for you to access the
PolyTrans and NuGraf plug-ins from inside Autodesk 3ds Max.
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Dkino Plug-ins Installer {(Demo Yersion)

Welcome to the Okino Plug-ing Installer [Demo]

Thig program will ingtall Okino's PoluT rans [#32] plug-in
modules into 3ds: Max, 30 Studio VIZ, Maya, Macromedia
Diirector (#86 only] and/or Softimage | %51

It iz strongly recommended that vou exit all windows
programs and all 30 applications before using this Setup
Program.

Click Cancel bo quit Setup and close any programs you
have mnning. Click Mest to continue with the Setup
progra.

WBRMING: This program is protected by copyright law
and international treaties.

Unauthorized reproduction or distribution of thiz program.
or any partion of it, may result in severe civil and criminal
penalties, and will be prozecuted to the maximum extent
pozsible under the law.

< Back Cancel

B Turbo Squid™ Tentacles from Turbo Squid— See Turbo Squid Tentacles
(32-bit only) on page 50 .

Optional Tools Installed from DVD 2

Autodesk Vault 2008 Server and Client and the Samples folder are available
on DVD 2.

Autodesk Vault 2008 Server, Client, and Plug-In

Autodesk Vault is the Autodesk data management solution and is integrated
with products such as Autodesk VIZ, Autodesk 3ds Max, and AutoCAD®.
Products such as Autodesk 3ds Max and AutoCAD ship with Autodesk Vault.

Generally, the system administrator installs both the server and client. Other
users can then install the plug-in to communicate with the server.

Find the Autodesk Vault 2008 Server and Client on DVD 2. Find the Autodesk
Vault 2008 and Autodesk Vault 5 Plug-ins on DVD 1. By default, the plug-ins
are selected for install when you install Autodesk 3ds Max.
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The following are the most common installation scenarios pertaining to
Autodesk Vault and Autodesk 3ds Max:

B If you only have Autodesk 3ds Max (and no other Autodesk product), then
you will not have Autodesk Vault and there is no need to install a Vault
plug-in.

B If your server is Autodesk Vault 2008, you should install the Autodesk
Vault 2008 plug-in.

B If your server is Autodesk Vault 5, you should install the Autodesk Vault
5 plug-in.

NOTE If you are unsure about your Autodesk Vault version, in the Help menu of
Autodesk Vault Explorer, click About Autodesk Vault Explorer.

See http://www.autodesk.com/vault for a complete description of Autodesk Vault.

Samples

The total collection of sample files is quite large. You can manually copy them
to your hard drive from DVD 2. The samples include maps and material library
files. Sample files have their file attributes set to Read-only, even if you copy
them to your local drive. Attempting to save a sample file using the same
name will result in an error unless you change the file attribute to Archive.

Installing Optional Tools

The process for installing optional tools depends on whether you are installing
the tools from DVD 1 or DVD 2.

Installing Optional Tools from DVD |

This procedure covers installing all optional tools except for Vault Client and
Server and Samples. The Vault Client and Server, and Sample Files are installed
from DVD 2. See Installing Optional Tools from DVD 2 on page 59 .

1 Insert DVD 1 of 2: Software, Documentation, Videos & Tutorials.
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NOTE If Autorun does not start the Autodesk 3ds Max 2008 Installation
Wizard, navigate to your DVD-ROM. Click the Setup.exe file to open the
Installation Wizard.

2 In the Installation Wizard, click Install Tools And Utilities.
3 On the Welcome to the Installation Wizard page, click Next.

4 On the Readme/Samples and Tutorials page you can:
B Click View Readme to view late-breaking information for this release.

B Click View Tutorials to open the folder of tutorial scene files that you
can copy to your computer. Use these scene files to complete the
tutorials (found in the Help menu of Autodesk 3ds Max 2008).

Click Next to continue with the install.

5 Choose the products you want to install on the Select the Products to
Install page. Click Next.

[ Kutodeskcr 3ds Mas 2008 BE=]|

Autodesk® 3ds Max® 2008 3ds Max 200z

Installation Wizard

Leam More Absut: Select the Products to Install
[ mistodssk Dazgn Review 2008 A
[ 3k o 2008 506
] 35 Mace 2008 ST Hedp Foe Visusal Studiod 2005

[ hstvrors Liosnss Marsger
[ Mamtumer L At ation Lk

Download from the Web: "

TN - - [ mtodesk CAD Manager Took 4.0

[Hsateport-Lie
[FIRPE %2 b plug-n
[Fleasinstm 2.5 Trial

[5] s Pty T e i bt (D)

[ barez CpenFight {Dema)

Documestation ([0

Support. 0} <k cwnesl

NOTE For Autodesk Combustion, Java, and QuickTime, only web links are
provided. You need to visit the corresponding web site to install them.
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WARNING Before installing the plug-ins (RPC™ Plug-Ins from ArchVision™,
Inc., EASYnat™ from Bionatics® s.a., Okino PolyTrans™ and NuGraf™ Demos,
Okino PolyTrans™ Plug-ins, and Turbo Squid™ Tentacles from Turbo Squid)
you need to install Autodesk 3ds Max 2008 and open it at least once. This
will improve the compatibility of the plug-ins with Autodesk 3ds Max 2008.
In the case of Turbo Squid™ Tentacles, which is installed at the same time as
Autodesk 3ds Max 2008, you only need to make sure you open Autodesk
3ds Max 2008 at least once, before opening Turbo Squid™ Tentacles.

On the Review - Configure - Install page, click Install if you want to accept
the default install location.

If you want the tool or utility installed in a different installation path,
click Configure, set the path and then click Configuration Complete and
then Install.

Click Finish when the Installation Complete page is displayed.

Installing Optional Tools from DVD 2

You can install Autodesk Vault 2008, including the Client, Data Management
Server, and Autodesk Design Review 2008 from DVD 2. For full documentation
on these components of Autodesk Vault 2008, refer to the Documentation
link on DVD 2. You can also install the sample files from this DVD.

To install Autodesk Vault 2008:

1

Insert DVD 2 of 2: Autodesk Vault & Sample Files.

NOTE If Autorun does not start the Autodesk 3ds Max 2008 Installation
Wizard, navigate to your DVD-ROM. Click the Setup.exe file to open the
Installation Wizard.

Click Install Products.

Click the Documentation link to read the accompanying documentation
for setup.

When you are ready, click Next.

On the Select the Products to Install Page, select the parts of Autodesk
Vault that you want to install.
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NOTE If you have not installed Microsoft IIS, you will be prompted to do so
or to accept the installation of AWS for a single-user setup only.

6 Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.

NOTE If you do not agree to the terms of the license and wish to terminate
the installation, click Cancel.

7 On the Personalize the Products page enter your details.

NOTE Be precise because you will not be able to change this information
once you begin the install, unless you uninstall and reinstall Autodesk Vault.

8 On the Review - Configure - Install page you can proceed with the default
install by simply clicking Install. This means that the default values are
selected. Click Configure to customize where Autodesk Vault 2008 and
Autodesk Design Review are installed. You can also customize several
options for the Autodesk Data Management Server. Refer to the Autodesk
Data Management Server Implementation Guide (.pdf) accessed by
clicking the Documentation link for further information.

9 When you have completed your selections, click Configuration Complete.
10 Click Install to start the installation process.

11 Click Finish when the install is complete.

To install the Sample Files:
1 Insert DVD 2 of 2: Autodesk Vault & Sample Files.

2 In Windows Explorer navigate to the Samples folder at the root of the
DVD.

3 Copy the folder to your local machine.
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Installation
Troubleshooting

If you have any problems when using Autodesk 3ds Max the following frequently asked
questions may help you find a solution. You may also find solutions to your problems on the
Autodesk Web Support page for Autodesk 3ds Max. See http://support.autodesk.com and select
Autodesk 3ds Max. Enter keywords describing your question in the Search field.

General Installation Issues

This section outlines common issues and their solutions that may arise while
performing a general install of your product(s).

Installing Autodesk 3ds Max on a Drive Besides C

By default, Autodesk 3ds Max will install to the drive containing the Program
Files folder. If that drive happens to be c:, then the Installation Wizard assumes
you want to install to a folder named c:\Program Files\ Autodesk \3ds Max 2008
(or c:\Program Files (x86)\Autodesk\3ds Max 2008 for the 32-bit version of
Autodesk 3ds Max running on a 64-bit machine.) If the installer detects that
you do not have sufficient space on the drive, a dialog will pop up asking you
to change the path to a drive which has sufficient space.

If you choose to change the drive location, be sure to specify the entire path of
the location where you want to install Autodesk 3ds Max. If you simply type
c:, you run the risk of installing the program into your system’s root folder.
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Checking DirectX Version

If your graphic card supports DirectX and you have drivers loaded, you can
run a utility that loads with the DirectX drivers. From the Windows Start
menu choose Run. In the Open field, type dxdiag.exe. This utility will display
a dialog showing you which version of DirectX is currently installed.

Finding Latest Service Packs

To find out if a patch or Service Pack is available for your product, visit the
Autodesk Product Support page at hitp://support.autodesk.com/.

Communication Center

See “Communication Center” in the Autodesk 3ds Max Help.

General Error Messages

The following are some solutions to specific error messages

‘Error: “Interactive 3D Renderer initialization failed. Please check your device
settings by using the -H command line option.”’

This error indicates that the video setting is incorrect. To fix this see Graphic
Display Drivers on page 33 .

‘Error: “TCP/IP error or Transport error — The network protocol TCP/IP is not
configured properly.”’

This error indicates an issue with your computer's network configuration.
Refer to the documentation included with Autodesk Backburner which you
can access from Start > Programs > Autodesk > Autodesk 3ds Max 2008 [32-
or 64-bit] > Help.
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File Issues

Backward Compatibility of Files

Files saved in the MAX format are forward compatible. You can try File >
Export from Autodesk 3ds Max and use File > Import in an earlier version of
Autodesk 3ds Max, but some data may be lost.

Sharing Files between Autodesk 3ds Max 2008 and
Autodesk VIZ 2008

Both programs use the MAX file format so you can share files. However, each
product has some specific features that may not work when the scene is opened
in the other product. For example, if a Autodesk 3ds Max scene containing a
particle system like Snow is opened in Autodesk VIZ, the Snow object is
replaced with a “stand-in” object and you will not be able to edit that object.
When the scene is saved and reopened in Autodesk 3ds Max, the Snow is
editable, and any new objects that were added in Autodesk VIZ will be present
(unless the new objects are specific to Autodesk VIZ.)

Opening or Linking to an Autodesk Architectural
Desktop Drawing or Model

When you open or link to an Autodesk® Architectural Desktop drawing or
model, certain objects may not show up. The most likely cause is that you are
missing the Architectural Desktop object enablers. AutoCAD 2008 and
AutoCAD vertical applications, such as Architectural Desktop (ADT), have
custom objects that are unique to the product. In order to view them in
Autodesk 3ds Max, you need the appropriate object enabler (OE). Object
enablers let you access, display, and manipulate these objects in AutoCAD
2008, and also the other vertical applications, including Autodesk 3ds Max.
For a list of downloadable Object Enablers, see
http://www.autodesk.com/autocad-object-enablers.
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Licensing and Activation Issues

This section outlines common issues and their solutions with regards to
software licenses and the licensing of your product(s). Also see Portable License
Utility on page 31 .

Sharing Your License between Business and Home

If you are an Autodesk 3ds Max subscription customer you can use your license
for both business and home use. The complete instructions for doing so are
found at our subscription site at:
http://pointa.autodesk.com/getPage?action=landing&id=homeUse.

NOTE You need a subscription login to access this page.

License Errors

If you receive a license error, you will need to reactivate your copy of Autodesk
3ds Max. You can use the Activation Wizard to complete your request.
Depending on the error, you may have a seven-day grace period, from the
time of your license error, before you must reactivate your product. After the
seven-day grace period, you will not be able to use the software again until
you have entered a new activation code. In certain cases, there is no grace
period.

If a new activation code is needed, the Activation Code dialog will appear
when you start Autodesk 3ds Max. You can only choose to activate the product
if you encounter a licensing error.

Exporting Your License to Another PC

The first time you export to another PC, you have to write the file (and it can
be anywhere, on a floppy, or shared network drive). But after that, you can
use the Transfer Code instead. Export normally, but instead of entering a file
name, on the Export Type Selection dialog, choose the Transfer Code option.
Write down the code and click Transfer. On the other PC, choose Transfer
Code again on the Import page, and enter the code.
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NOTE Transfer codes can't be reused; you'll get a new one each time.

Lost Exported License

On the PC where you last worked, run the PLU (see Portable License Utility
on page 31 ) and export the license again. Then make a new floppy. This works
because it remembers which PC you exported it to. You can only re-export to
the same PC.

Lost Exported License with Hard Disk Failure

Contact the Autodesk registration center directly by phone, fax, e-mail, or
online. A technician will help you re-initiate your Autodesk 3ds Max license.
See Registering and Activating Autodesk 3ds Max on page 26 .

Error Message when Importing License

Error 1290, “The supplied data is not destined for this machine. Please check
that the file has been transferred to the correct machine.”

This happens if on PC1, you select PC2 and export to it, creating a floppy.
You take that floppy to PC3 and try to import. Unfortunately it wasn't intended
to go to PC3. This restriction is necessary for security reasons. If you want the
license on PC3, you'll have to import on PC2, and then export it, selecting
PC3 as the destination.

Major System Failure without Parking the License

If the hard drive is damaged beyond recovery, it is unlikely the license will be
retrievable. You will have to resubmit to get a new activation code after the
operating system is reloaded. See Registering and Activating Autodesk 3ds
Max on page 26 .
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Using the PLU with Partner Applications

If you use the PLU to transfer your Autodesk 3ds Max license, the ability to
run partner plug-ins is also transferred. This means that if the plug-ins are
installed on the transferred machine, they can be made functional by using
the same plug-in activation as on the original machine.

NOTE Only the plug-in information is transferred, not the actual plug-in license.

Activating During Non-Business Hours

Autodesk 3ds Max includes an electronic registration and activation feature
that allows users (in some geographic locations) to obtain an activation code
at any time. You can only attempt to activate Autodesk 3ds Max a certain
number of times before you will need to contact a authorization code
representative to assist you with your activation. See Registering and Activating
Autodesk 3ds Max on page 26.

Reactivating Autodesk 3ds Max

The activation code is unique in every instance and cannot be used more than
once.

Reactivating Partner Applications when Reactivating
Autodesk 3ds Max

Once activated, partner applications shouldn’t need reactivation. If, for some
reason, you need to reactivate your license for Autodesk 3ds Max, partner
applications will operate correctly once Autodesk 3ds Max is running again.

Networking Issues

This section outlines common issues and their solutions with regards to
performing a network installation or configuring your network license server(s).
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Locating Your Server Name

When installing a network licensed product, you must specify the name of
the server that will run the Network License Manager. If you don’t know the
server name, you can quickly find it by opening a Windows command prompt
on the system that will be the Network License Manager. At the prompt, enter
ipconfig /all and note the Host Name entry.

Log Files

There are two types of log files that can be generated that monitor information
about deployments and installations.

The Network log file keeps a record of all workstations that run the
deployment. The log lists the user name, workstation name, and the status of
the installation. Refer to this file for status information and details about
problems that users may have encountered during installation.

The Client log file contains detailed installation information for each
workstation. This information may be useful in diagnosing installation
problems. The client log is located in the \Temp directory of each client
workstation.

Creating Custom Desktop Shortcuts

You can choose to create custom desktop shortcuts that use command line
switches to specify several options when you start the program. For example,
command line switches can be set to run a script during program launch,
create a drawing based on a template or prototype drawing, or designate a
workspace that should be restored on startup.

To create a custom desktop shortcut:
1 Right-click your Autodesk 3ds Max 2008 icon on the desktop.

2 On the Shortcut Tab, in the Target box, add your switch after the
quotation marks. For example:

"C:\Program Files\Autodesk\3ds Max 2008\3dsmax.exe" -g

Locating Your Server Name | 67



NOTE For setups with a 64-bit operating system and 32-bit version of
Autodesk 3ds Max you need to use this switch instead:

"C:\Program Files (x86)\Autodesk\3ds Max 2008\3dsmax.exe" -g

3 Click Apply.

When you use this desktop shortcut, your switch will be applied. In this
example, Autodesk 3ds Max will start without the splash screen showing.

NOTE There are several other switches you can use following this procedure.
For a list see “Starting 3ds Max from the Command Line.”

Uninstall and Maintenance Issues

This section describes common issues and their solutions resulting from adding
and removing features, reinstalling or repairing your installation, and
uninstalling products.

Installation Location

After your product is installed, you cannot change the installation path from
the Add/Remove Features page. Changing the path while adding features
would result in program corruption.

Files Remaining After an Uninstall

If you uninstall the product, some files will remain on your system such as
files you've created or edited, like drawings or custom menus.

Your license file also stays on your workstation when you uninstall your
product. If you reinstall on the same workstation, the license information
remains valid and you do not have to reactivate the product.

For complete details on removing all remaining files, refer to the Autodesk 3ds
Max 2008 Readme.
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